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All truths are easy to understand once they are discovered; the point is to
discover them.
—Galileo Galilei

In this lab we expand on the ProModel concepts discussed in Chapters 3 and 6.
Section L12.1 introduces the concept of attributes; Section L12.2 shows its application in the calculation of cycle times; and Section L12.3 shows the process of
sortation, sampling inspection, and rework. In Section L12.4 we show how to
merge two different submodules. Section L12.5 discusses various aspects of
machine breakdowns and maintenance; Section L12.6 shows how ProModel can
conveniently model shift-working patterns; Section L12.7 shows the application
of ProModel in a job shop; Section L12.8 introduces the modeling of priorities;
and Section L12.9 has a couple of examples of pull system applications in manufacturing. Costs are modeled and tracked in Section L12.10. Section L12.11 shows
how to import background graphics into a model, and Section L12.12 shows how
to deﬁne and display various views of a model.

L12.1 Attributes
Attributes can be deﬁned for entities or for locations. Attributes are placeholders
similar to variables but are attached to speciﬁc entities or locations and usually
contain information about that entity or location. Attributes are changed and assigned when an entity executes the line of logic that contains an operator, much
like the way variables work. Some examples of attributes are part type, customer
number, and time of arrival of an entity, as well as length, weight, volume, or
some other characteristic of an entity.
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To deﬁne an attribute use the attribute editor, as follows:
1. Go to the Build/More Elements/Attributes menu and create a name (ID)
for the attribute.
2. Select the type of attribute—integer or real.
3. Select the class of attribute—entity or location.

L12.1.1 Using Attributes to Track Customer Types
Problem Statement
Customers visit the neighborhood barbershop Fantastic Dan for a haircut. Among
the customers there are 20 percent children, 50 percent women, and 30 percent
men. The customer interarrival time is triangularly distributed with a minimum,
mode, and maximum of seven, eight, and nine minutes respectively. The haircut
time (in minutes) depends on the type of customer and is given in Table L12.1.
This time also includes the initial greetings and the transaction of money at the end
of the haircut. Run the simulation model for one day (480 minutes).
a. About how many customers of each type does Dan process per day?
b. What is the average number of customers of each type waiting to get a
haircut? What is the maximum?
c. What is the average time spent by a customer of each type in the salon?
What is the maximum?
Two locations (Barber Dan and Waiting for Dan) and an entity (Customer) are deﬁned. Customer_Type is deﬁned as an attribute (type  integer and classiﬁcation 
entity) as shown in Figure L12.1. The process/routing and customer arrivals are
deﬁned as shown in Figures L12.2 and L12.3. A snapshot of the simulation model
is shown in Figure L12.4.
FIGURE L12.1
Customer_Type declared as an attribute.

TABLE L12.1 The Haircut Time for All Customers
Haircut Time (minutes)
Customers

Mean

Half-Width

Children
Women
Men

8
12
10

2
3
2
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FIGURE L12.2
Process and routing tables for Fantastic Dan.

FIGURE L12.3
Arrival of customers at Fantastic Dan.

FIGURE L12.4
Simulation model for Fantastic Dan.
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L12.2 Cycle Time
The Clock and Log are functions built into ProModel to allow us to keep track of
system events such as cycle time, lead time, or ﬂow time within the system. The
Clock function returns the current simulation clock time in hours, minutes, or seconds. The value returned is real.
The Log function is used to subtract an expression from the current simulation clock time and stores the result with a text string header.
Time_In = Clock()
Log "Cycle Time =", Time_In

For the example in Section L12.1, ﬁnd
a. The cycle time for each type of customer of Barber Dan.
b. The average cycle time for all customers.
Deﬁne Time_In as an attribute to track the time of arrival for all customer types.
Figure L12.5 shows the setting of the attribute Time_In and also the logging of the
average cycle time. The cycle times for children, women, and men are reported in
Figure L12.6.
FIGURE L12.5
Setting the attribute Time_In and logging the cycle time.

FIGURE L12.6
The minimum,
maximum, and
average cycle times
for various customers.
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L12.3 Sorting, Inspecting a Sample, and Rework
Problem Statement
Orders for two types of widgets (widget A and widget B) are received by WidgetsR-Us Manufacturing Inc. Widget A orders arrive on average every ﬁve minutes
(exponentially distributed), while widget B orders arrive on average every ten minutes (exponentially distributed). Both widgets arrive at the input queue. An
attribute Part_Type is deﬁned to differentiate between the two types of widgets.
Widget A goes to the lathe for turning operations that take Normal(5,1) minutes. Widget B goes on to the mill for processing that takes Uniform(6,2) minutes.
Both widgets go on to an inspection queue, where every ﬁfth part is inspected.
Inspection takes Normal(6,2) minutes. After inspection, 70 percent of the widgets
pass and leave the system; 30 percent of the widgets fail and are sent back to the
input queue for rework. Determine the following:
a.
b.
c.
d.
e.

How many widgets of each type are shipped each week (40-hour week)?
What is the cycle time for each type of widget?
What are the maximum and minimum cycle times?
What is the number of widgets reworked each week?
What is the average number of widgets waiting in the inspection queue?

Five locations (Mill, Input_Queue, Lathe, Inspect, and Inspect_Q) are deﬁned for
this model. Three variables are deﬁned, as in Figure L12.7. Figure L12.8 shows
how we keep track of the machined quantity as well as the probabilistic routings
FIGURE L12.7
Variables for Widgets-R-Us.

FIGURE L12.8
Keeping track of machined_qty and probabilistic routings at the Inspect location.
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FIGURE L12.9
Simulation model for Widgets-R-Us.

after inspection. Figure L12.9 shows the complete simulation model with counters added for keeping track of the number of widgets reworked and the number
of widgets shipped.

L12.4 Merging a Submodel
Sometimes a large model is built in smaller segments. A model segment can be a
manufacturing cell or a department. Different analysts can build each segment.
After all segments are complete, they can be merged together to form a single uniﬁed model.
The Merge Model option in the File menu allows two or more independent
(complete or incomplete) models to be merged together into a single model. Entity and attribute names common to both models are considered common elements in the merged model. Duplicate locations, resources, or path networks must
ﬁrst be renamed or deleted from the original merging model. If the graphic libraries are different, the user has an option to append the merging model’s graphic
library to the base model’s graphic library. All other duplicate elements cause a
prompt to appear with a choice to delete the duplicate element.
Problem Statement
Poly Casting Inc. (Lab 7, Section L7.4) decides to merge with El Segundo Composites (Lab 7, Section L7.6.1). The new company is named El Segundo
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Castings N’ Composites. Merge the model for Section L7.4 with the model for
Section L7.6.1. All the ﬁnished products—castings as well as composites—are
now sent to the shipping queue and shipping clerk. The model in Section L7.4 is
shown in Figure L12.10. The complete simulation model, after the model for Section L7.6.1 is merged, is shown in Figure L12.11. After merging, make the necessary modiﬁcations in the process and routing tables.
We will make suitable modiﬁcations in the Processing module to reﬂect these
changes (Figure L12.12). Also, the two original variables in Section L7.4 (WIP
and PROD_QTY) are deleted and four variables are added: WIPCasting, WIPComposite, PROD_QTY_Casting, and PROD_QTY_Composite.

FIGURE L12.10
The layout of the
simulation model for
Section L7.4.

FIGURE L12.11
Merging the models from Section L7.4 and Section L7.6.1.
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FIGURE L12.12
Changes made to the process table after merging.

L12.5 Preventive Maintenance and Machine Breakdowns
Downtime stops a location or resource from operating. Downtime can occur in one
of two ways: preventive maintenance or breakdown. A down resource (or location)
no longer functions and is not available for use. Downtimes may represent scheduled interruptions such as shifts, breaks, or scheduled maintenance. They may also
represent unscheduled and random interruptions such as equipment failures.
The mean time between failures (MTBF) can be calculated as the reciprocal of
the failure rate (distribution of failure over time). Often MTBF will follow a negative exponential distribution. In particular, the probability of failure before time
T is given by 1 − e−T /MTBF . The reliability is viewed as performance over time and
is the probability that a given location or resource will perform its intended
function for a speciﬁed length of time T under normal conditions of use:
Reliability = P(no failure before time T ) = e−T /MTBF
The mean time to repair (MTTR) refers to the time the location or resource remains down for repair. The MTTR depends on the ease and/or cost with which a
location or resource can be maintained or repaired.
For single-capacity locations, downtime of a location or resource can be
scheduled at regular intervals based on the clock time that has expired, the number of entities processed at a location, the usage of the machine (resource) in time,
or a change in entity type. Unscheduled breakdown of a machine can also be modeled in a similar fashion.
To model preventive maintenance or breakdowns, use the following procedure:
1. Go to the Build/Locations menu.
2. Click on the DT button.
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3. Enter the frequency of downtime:
a. Clock based.
b. Number of entries based.
c. Usage based.
4. Enter the ﬁrst time downtime occurs.
5. Enter the priority of the downtime.
6. In the logic ﬁeld, enter any logic associated with downtime.
Example:
DISPLAY "The Lathe is down for preventive maintenance"
WAIT N(20,5) min

7. To disable the downtime feature, click Yes in the disable ﬁeld. Otherwise,
leave this ﬁeld as No.

L12.5.1 Downtime Using MTBF and MTTR Data
The lathe and the mill at Widgets-R-Us Manufacturing Inc. (Section L12.3)
have the maintenance schedule shown in Table L12.2. The logic for the preventive maintenance operation is created in Figure L12.13. The processes and
FIGURE L12.13
The logic for preventive maintenance at Widgets-R-Us Manufacturing Inc.

TABLE L12.2 Maintenance Schedule for Machines at Widgets-R-Us
Machine

Time between Repairs

Time to Repair

Lathe
Mill

120 minutes
200 minutes

N(10,2) minutes
T(10,15,20) minutes
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FIGURE L12.14
Processes and routings at Widgets-R-Us Manufacturing Inc.

FIGURE L12.15
Complete simulation model for Widgets-R-Us Manufacturing Inc.

routings are shown in Figure L12.14. Figure L12.15 shows the complete simulation model.

L12.5.2 Downtime Using MTTF and MTTR Data
Reliability of equipment is frequently calibrated in the ﬁeld using the mean time
to failure (MTTF) data instead of the MTBF data. MTTR is the expected time
between the end of repair of a machine and the time the machine fails. Data
collected in the ﬁeld are often based on TTF for clock-based failures.

Harrell−Ghosh−Bowden:
Simulation Using
ProModel, Second Edition

II. Labs

Lab 12

12. Intermediate Modeling
Concepts

Intermediate Modeling Concepts

© The McGraw−Hill
Companies, 2004

589

Problem Statement
The turning center in this machine shop (Figure L12.16) has a time to failure
(TTF) distribution that is exponential with a mean of 10 minutes. The repair time
(TTR) is also distributed exponentially with a mean of 10 minutes.
This model shows how to get ProModel to implement downtimes that use
time to failure (TTF) rather than time between failures (TBF). In practice, you
most likely will want to use TTF because that is how data will likely be available to you, assuming you have unexpected failures. If you have regularly
scheduled downtimes, it may make more sense to use TBF. In this example, the
theoretical percentage of uptime is MTTF/(MTTF + MTTR), where M indicates
a mean value. The ﬁrst time to failure and time to repair are set in the variable
initialization section (Figure L12.17). Others are set in the downtime logic (Figure L12.18).
The processing and routing tables are shown in Figure L12.19. Run this
model for about 1000 hours, then view the batch mean statistics for downtime by
picking “averaged” for the period (Figure L12.20) when the output analyzer (classical) comes up. The batch mean statistics for downtime for the turning center are
shown in Figure L12.21. (This problem was contributed by Dr. Stephen Chick,
University of Michigan, Ann Arbor.)

FIGURE L12.16
Layout of the machine
shop—modeling
breakdown with TTF
and TTR.

FIGURE L12.17
Variable
initializations.
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FIGURE L12.18
Clock downtime logic.

FIGURE L12.19
Process and routing tables.

FIGURE L12.20
Average of all the
batches in the
Classical ProModel
Output Viewer.

FIGURE L12.21
Batch mean statistics for downtime.
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L12.6 Operator Shifts
ProModel offers an excellent interface to include the operator (location or resource) shift working schedules in the simulation model. The shift work for each
operator in the model can be deﬁned separately. Work cycles that repeat either
daily or weekly can be deﬁned.
Problem Statement
Orders for two types of widgets (widget A and widget B) are received by
Widgets-R-Us Manufacturing Inc. Widget A orders arrive on average every
5 minutes (exponentially distributed), while widget B orders arrive on average
every 10 minutes (exponentially distributed). Both widgets arrive at the input
queue. An attribute Part_Type is deﬁned to differentiate between the two types of
widgets.
Widget A goes on to the lathe for turning operations that take Normal(5,1) minutes. Widget B goes on to the mill for processing that takes Uniform(4,8) minutes.
Both widgets go on to an inspection queue, where every ﬁfth part is inspected.
Inspection takes Normal(6,2) minutes. After inspection, 70 percent of the widgets
pass and leave the system, while 30 percent of the widgets fail and are sent back to
the input queue for rework.
An operator is used to process the parts at both the lathe and the mill. The
operator is also used to inspect the part. The operator moves the parts from
the input queue to the machines as well as to the inspection station. The operator
is on a shift from 8 A.M. until 5 P.M. with breaks as shown in Table L12.3 and
Figures L12.22 and L12.23.
Use the DISPLAY statement to notify the user when the operator is on a break.
Set up a break area (Figure L12.24) for the operator by extending the path network to a break room and indicating the node as the break node in Resource specs.
The processes and the routings at Widgets-R-Us are shown in Figure L12.25.
Determine the following:
a. How many widgets of each type are shipped each week (40-hour
week).
b. The cycle time for each type of widgets.
c. The maximum and minimum cycle times.

TABLE L12.3 The Operator Break Schedule at
Widgets-R-Us Manufacturing Inc.
Breaks

From

To

Coffee break
Lunch break
Coffee break

10 A.M.
12 noon
3 P.M.

10:15 A.M.
12:45 P.M.
3:15 P.M.
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FIGURE L12.22
The operator Joe’s weekly work and break times at Widgets-R-Us.

FIGURE L12.23
Assigning the Shift File to the operator Joe.

d. The number of widgets reworked each week.
e. The average number of widgets waiting in the inspection queue.
Run the model with and without shift breaks (Figure L12.26). What difference do you notice in these statistics? How can you improve the system?
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FIGURE L12.24
The layout and path network at Widgets-R-Us.

FIGURE L12.25
Processes and routings at Widgets-R-Us.

FIGURE L12.26
A snapshot during the
simulation model run
for Widgets-R-Us.
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L12.7 Job Shop
A job shop is a collection of processing centers through which jobs are routed in
different sequences depending on the characteristics of the particular job. It is a
common method of grouping resources for producing small lots with widely varying processing requirements.
Each job in a job shop usually has a unique routing sequence. Job shops usually have a process layout. In other words, similar processes are geographically
grouped together.
Problem Statement
In Joe’s Jobshop there are three machines through which three types of jobs are
routed. All jobs go to all machines, but with different routings. The data for job
routings and processing times (minutes) are given in Table L12.4. The process
times are exponentially distributed with the given average values. Jobs arrive at
the rate of Exponential(30) minutes. Simulate for 10 days (80 hours). How many
jobs of each type are processed in 10 days?
Figures L12.27, L12.28, L12.29, L12.30, and L12.31 show the locations,
entities, variables, processes, and layout of Joe’s Jobshop.

FIGURE L12.27
Locations at Joe’s Jobshop.

TABLE L12.4 Summary of Process Plan for Joe’s Jobshop
Jobs

Machines

Process Times (minutes)

Job Mix

A
B
C

2–3–1
1–2–3
3–1–2

45–60–75
70–70–50
50–60–60

25%
35%
40%
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FIGURE L12.28
Entities at Joe’s
Jobshop.

FIGURE L12.29
Variables to track jobs
processed at Joe’s
Jobshop.

FIGURE L12.30
Processes and routings at Joe’s Jobshop.
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FIGURE L12.31
Layout of Joe’s Jobshop.

L12.8 Modeling Priorities
Priorities allow us to determine the order in which events occur in the simulation.
The most common uses of priorities are
1. Selecting among upstream processes.
2. Selecting among downstream processes—already discussed in Lab 7,
Section L7.3.
3. Selecting resources.
4. Prioritizing downtimes—discussed in Section L12.5.

L12.8.1 Selecting among Upstream Processes
This is the process of choosing among a set of upstream processes or queues for
entity removal and routing to a downstream process. When one downstream
destination exists and two or more upstream entities are competing to get there,
priorities can be used. In the example in Figure L12.32 two entities at different
locations (Process A and Process B) are both trying to get to Process C.
Problem Statement
At Wang’s Export Machine Shop in the suburbs of Chicago, two types of jobs
are processed: domestic and export. The rate of arrival of both types of jobs is
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FIGURE L12.32
Choosing among upstream processes.

TABLE L12.5 Process Times at Wang’s Export
Machine Shop
Machine

Process Time

Machining center
Lathe

Triangular(10,12,18) minutes
Triangular(12,15,20) minutes

TABLE L12.6 Distances between Locations
From

To

Distance (feet)

Incoming
Machining center
Lathe
Outgoing

Machining center
Lathe
Outgoing
Incoming

200
400
200
400

Exponential(60) minutes. All jobs are processed through a machining center and
a lathe. The processing times (Table L12.5) for all jobs are triangularly distributed. A forklift truck that travels at the rate of 50 feet/minute handles all the material. Export jobs are given priority over domestic jobs for shop release—that is,
in moving from the input queue to the machining center. The distance between the
stations is given in Table L12.6. Simulate for 16 hours.
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FIGURE L12.33
Forklift resource speciﬁed for Wang’s Export Machine Shop.

Five locations are deﬁned: Lathe, Machining_Center, In_Q_Domestic,
In_Q_Export, and Outgoing_Q. Two entities (domestic and export) are deﬁned.
Both these entities arrive with an interarrival time that is exponentially distributed
with a mean of 60 minutes. The resource (forklift) and its path network are shown
in Figures L12.33 and L12.34, respectively. The processes and routings are shown
in Figure L12.35. Note that the priority of domestic jobs is set at a value of 1
(Figure L12.33), while that of export jobs is set at 10. Higher priority numbers
signify higher priority in terms of selecting the upstream process. The priorities
can range from 0 to 999. The default priority is 0.

L12.8.2 Selecting Resources
Priorities can also be used to decide which process, among two or more competing processes requesting the same resource, will have priority in capturing that
resource.
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FIGURE L12.34
Deﬁnition of path network for forklift for Wang’s Export Machine Shop.

FIGURE L12.35
Processes and routings deﬁned for Wang’s Export Machine Shop.
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Problem Statement
At Wang’s Export Machine Shop, two types of jobs are processed: domestic and
export. Mr. Wang is both the owner and the operator. The rate of arrival of both
types of jobs is Exponential(60) minutes. Export jobs are processed on machining
center E, and the domestic jobs are processed on machining center D. The
processing times for all jobs are triangularly distributed (10, 12, 18) minutes.
Mr. Wang gives priority to export jobs over domestic jobs. The distance between
the stations is given in Table L12.7.
Five locations (Machining_Center_D, Machining_Center_E, In_Q_Domestic,
In_Q_Export, and Outgoing_Q) are deﬁned. Two types of jobs (domestic and export) arrive with an exponential interarrival frequency distribution of 60 minutes.
Mr. Wang is deﬁned as a resource in Figure L12.36. The path network and the
processes are shown in Figures L12.37 and L12.38 respectively. Mr. Wang is getting old and can walk only 20 feet/minute with a load and 30 feet/minute without a
load. Simulate for 100 hours.
Priorities of resource requests can be assigned through a GET, JOINTLY GET,
or USE statement in operation logic, downtime logic, or move logic or the subroutines called from these logics. Priorities for resource downtimes are assigned in
the Priority ﬁeld of the Clock and Usage downtime edit tables.
Note that the priority of the resource (Mr_Wang) is assigned through the GET
statement in the operation logic (Figure L12.38). The domestic orders have a resource request priority of 1, while that of the export orders is 10.

FIGURE 12.36
Resource deﬁned for Wang’s Export Machine Shop.

TABLE L12.7 Distances between Stations at Wang’s Export
Machine Shop
From

To

Distance (feet)

Machining_Center_E
Machining_Center_D
Outgoing

Machining_Center_D
Outgoing
Machining_Center_E

200
200
200
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FIGURE L12.37
Path network deﬁned at Wang’s Export Machine Shop.

FIGURE L12.38
Processes and routings deﬁned at Wang’s Export Machine Shop.

The results (partial) are shown in Figure L12.39. Note that the average time
waiting for the resource (Mr_Wang) is about 50 percent more for the domestic
jobs (with lower priority) than for the export jobs. The average time in the system
for domestic jobs is also considerably more than for the export jobs.
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FIGURE L12.39
Part of the results showing the entity activities.

L12.9 Modeling a Pull System
A pull system is a system in which locations produce parts only on downstream
demand. There are two types of pull systems:
1. Those based on limited buffer or queue sizes.
2. Those based on more distant “downstream” demand.
The ﬁrst type of pull system is modeled in ProModel by deﬁning locations
with limited capacity. In this type of system, upstream locations will be able to
send parts to downstream locations only when there is capacity available.

L12.9.1 Pull Based on Downstream Demand
The second type of pull system requires the use of a SEND statement from a downstream location to trigger part movement from an upstream location.
Problem Statement
In the Milwaukee Machine Shop, two types of jobs are processed within a machine cell. The cell consists of one lathe and one mill. Type 1 jobs must be
processed ﬁrst on the lathe and then on the mill. Type 2 jobs are processed only on
the mill (Table L12.8). All jobs are processed on a ﬁrst-in, ﬁrst-out basis.
Brookﬁeld Forgings is a vendor for the Milwaukee Machine Shop and produces all the raw material for them. Forgings are produced in batches of ﬁve every
day (exponential with a mean of 24 hours). However, the customer supplies them
only on demand. In other words, when orders arrive at the Milwaukee Machine
Shop, the raw forgings are supplied by the vendor (a pull system of shop loading).
Simulate for 100 days (2400 hours). Track the work-in-process inventories and
the production quantities for both the job types.
Six locations (Mill, Lathe, Brookﬁeld_Forgings, Order_Arrival, Lathe_Q,
and Mill_Q) and four entities (Gear_1, Gear_2, Orders_1, and Orders_2) are
deﬁned. The arrivals of various entities are deﬁned as in Figure L12.40. Four
variables are deﬁned as shown in Figure L12.41. The processes and routings are
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FIGURE L12.40
Arrival of orders at the Milwaukee Machine Shop.

FIGURE L12.41
Variables deﬁned for
the Milwaukee
Machine Shop.

TABLE L12.8 Order Arrival and Process Time Data
for the Milwaukee Machine Shop
Job
Type

Number of
Orders

Time between
Order Arrival

Processing Time
on Lathe

Processing Time
on Mill

1
2

120
100

E(8) hrs
E(10) hrs

E(3) hrs
—

U(3,1) hrs
U(4,1) hrs

shown in Figure L12.42. Note that as soon as a customer order is received at the
Milwaukee Machine Shop, a signal is sent to Brookﬁeld Forgings to ship a gear
forging (of the appropriate type). Thus the arrival of customer orders pulls the raw
material from the vendor. When the gears are fully machined, they are united
(JOINed) with the appropriate customer order at the orders arrival location. Figure L12.43 shows a layout of the Milwaukee Machine Shop and a snapshot of the
simulation model.

L12.9.2 Kanban System
The kanban system is one of the methods of control utilized within the Toyota
production system (TPS). The basic philosophy in TPS is total elimination of
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FIGURE L12.42
Processes and routings deﬁned for the Milwaukee Machine Shop.

FIGURE L12.43
Simulation model for the Milwaukee Machine Shop.

waste in machines, equipment, and personnel. To make the ﬂow of things as
close as possible to this ideal condition, a system of just-in-time procurement
of material is used—that is, obtain material when needed and in the quantity
needed.
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“Kanban” literally means “visual record.” The word kanban refers to the
signboard of a store or shop, but at Toyota it simply means any small sign displayed in front of a worker. The kanban contains information that serves as a work
order. It gives information concerning what to produce, when to produce it, in
what quantity, by what means, and how to transport it.
Problem Statement
A consultant recommends implementing a production kanban system for Section 12.9.1’s Milwaukee Machine Shop. Simulation is used to ﬁnd out how
many kanbans should be used. Model the shop with a total of ﬁve kanbans.
The kanban procedure operates in the following manner:
1. As soon as an order is received by the Milwaukee Machine Shop, they
communicate it to Brookﬁeld Forgings.
2. Brookﬁeld Forgings holds the raw material in their own facility in the
forging queue in the sequence in which the orders were received.
3. The production of jobs at the Milwaukee Machine Shop begins only
when a production kanban is available and attached to the production
order.
4. As soon as the production of any job type is ﬁnished, the kanban is
detached and sent to the kanban square, from where it is pulled by
Brookﬁeld Forgings and attached to a forging waiting in the forging
queue to be released for production.
The locations at the Milwaukee Machine Shop are deﬁned as shown in Figure L12.44. Kanbans are deﬁned as virtual entities in the entity table (Figure L12.45).
The arrival of two types of gears at Brookﬁeld Forgings is shown in the arrivals table (Figure L12.46). This table also shows the arrival of two types of customer orders at the Milwaukee Machine Shop. A total of ﬁve kanbans are generated
at the beginning of the simulation run. These are recirculated through the system.
FIGURE L12.44
Locations at the Milwaukee Machine Shop.
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FIGURE L12.45
Entities deﬁned for
Milwaukee Machine
Shop.

FIGURE L12.46
Arrival of orders at Milwaukee Machine Shop.

FIGURE L12.47
Simulation model of a kanban system for the Milwaukee Machine Shop.
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FIGURE L12.48
Process and routing tables for the Milwaukee Machine Shop.

Figure L12.47 shows the layout of the Milwaukee Machine Shop. The
processes and the routings are shown in Figure L12.48. The arrival of a customer
order (type 1 or 2) at the orders arrival location sends a signal to Brookﬁeld Forgings in the form of a production kanban. The kanban is temporarily attached
(LOADed) to a gear forging of the right type at the Order_Q. The gear forgings are
sent to the Milwaukee Machine Shop for processing. After they are fully
processed, the kanban is separated (UNLOADed). The kanban goes back to the kanban square. The ﬁnished gear is united (JOINed) with the appropriate customer
order at the orders arrival location.

L12.10 Tracking Cost
ProModel 6.0 includes a cost-tracking feature. The following costs can be
monitored:
1. Location cost
2. Resource cost
3. Entity cost
The cost dialog can be accessed from the Build menu (Figure L12.49).
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FIGURE 12.49
The Cost option in the
Build menu.

FIGURE L12.50
The Cost dialog box—Locations option.

Locations
The Locations Cost dialog box (Figure L12.50) has two ﬁelds: Operation Rate
and Per Operation Rate speciﬁes the cost per unit of time to process at the selected
location. Costs accrue when an entity waits at the location or uses the location. Per
is a pull-down menu to set the time unit for the operation rate as second, minute,
hour, or day.
Resources
The Resources Cost dialog box (Figure L12.51) has three ﬁelds: Regular Rate,
Per, and Cost Per Use. Regular Rate speciﬁes the cost per unit of time for a resource used in the model. This rate can also be set or changed during run time
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FIGURE L12.51
The Cost dialog box—Resources option.

FIGURE L12.52
The Cost dialog box—Entities option.

using the SETRATE operation statement. Per is a pull-down menu, deﬁned before.
Cost Per Use is a ﬁeld that allows you to deﬁne the actual dollar cost accrued
every time the resource is obtained and used.
Entities
The Entities Cost dialog box (Figure L12.52) has only one ﬁeld: Initial Cost.
Initial Cost is the cost of the entity when it arrives to the system through a scheduled arrival.
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Increment Cost
The costs of a location, resource, or entity can be incremented by a positive or
negative amount using the following operation statements:
•
•
•

IncLocCost—Enables

you to increment the cost of a location.
you to increment the cost of a resource.
IncEntCost—Enables you to increment the cost of an entity.
IncResCost—Enables

For more information on the cost-tracking feature of ProModel, refer to Lab 6
of the ProModel manual.
Problem Statement
Raja owns a manufacturing cell consisting of two mills and a lathe. All jobs are
processed in the same sequence, consisting of an arriving station, a lathe, mill 1,
mill 2, and an exit station. The processing time on each machine is normally distributed with a mean of 60 seconds and standard deviation of 5. The arrival rate of
jobs is exponentially distributed with a mean of 120 seconds.
Raja, the material handler, transports the jobs between the machines and the
arriving and exit stations. Job pickup and release times are uniformly distributed
between six and eight seconds. The distances between the stations are given in
Table L12.9. Raja can walk at the rate of 150 feet/minute when carrying no load.
However, he can walk only at the rate of 80 feet/minute when carrying a load.
The operation costs for the machines are given in Table L12.10. Raja gets paid
at the rate of $60 per hour plus $5 per use. The initial cost of the jobs when they
enter the system is $100 per piece. Track the number of jobs produced, the total
cost of production, and the cost per piece of production. Simulate for 80 hours.

TABLE L12.9 Distances between Stations
From

To

Distance (feet)

Arriving
Lathe
Mill 1
Mill 2
Exit

Lathe
Mill 1
Mill 2
Exit
Arrive

40
80
60
50
80

TABLE L12.10 Operation Costs at Raja’s
Manufacturing Cell
Machine

Operation Costs

Lathe
Mill 1
Mill 2

$10/minute
$18/minute
$22/minute
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FIGURE L12.53
Processes and routings at Raja’s manufacturing cell.

FIGURE L12.54
Simulation model of Raja’s manufacturing cell.

Five locations (Lathe, Mill1, Mill2,Arrive_Station, and Exit_Station) and three
variables (Total_Prod, Cost_Per_Part, and Total_Cost) are deﬁned. The processes
are shown in Figure L12.53. The simulation model is shown in Figure L12.54.

L12.11 Importing a Background
Background graphics work as a static wallpaper and enhance the look of a simulation model. They make the model realistic and provide credibility during presentations. Many different graphic formats can be imported such as .BMP, .WMF,
.GIF, and .PCX. Drawings in CAD formats like .DWG must be saved in one of
these ﬁle formats before they can be imported. .BMPs and .WMFs can be copied
to the clipboard from other applications and passed directly into the background.
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AutoCAD drawings can also be copied to the clipboard and pasted into the background. The procedure is as follows:
1. With the graphic on the screen, press <Ctrl> and <C> together.
Alternatively, choose Copy from the Edit menu. This will copy the
graphic into the Windows clipboard.
2. Open an existing or new model ﬁle in ProModel.
3. Press <Ctrl> and <V> together. Alternatively, choose Paste from the
Edit menu.
This action will paste the graphic as a background on the layout of the model.
Another way to import backgrounds is to use the Edit menu in ProModel:
1.
2.
3.
4.

Choose Background Graphics from the Build menu.
Select Front of or Behind grid.
Choose Import Graphic from the Edit menu.
Select the desired ﬁle and ﬁle type. The image will be imported into the
layout of the model.
5. Left-click on the graphic to reposition and resize it, if necessary.
“Front of grid” means the graphic will not be covered by grid lines when the
grid is on. “Behind grid” means the graphic will be covered with grid lines when
the grid is on.

L12.12 Deﬁning and Displaying Views
Speciﬁc areas of the model layout can be predeﬁned and then quickly and easily
viewed in ProModel. Each view can be given a unique name and can have a suitable magniﬁcation. These views can be accessed during editing of the model by
selecting Views from the View menu (Figure L12.55) or by using the keyboard
shortcut key. Views can also be accessed in real time during the running of the
model with a VIEW "mill_machine" statement.
Problem Statement
For the Shipping Boxes Unlimited example in Lab 7, Section L7.7.2, deﬁne the
following six views: Monitor Queue, Box Queue, Inspect Queue, Shipping
Queue, Pallet Queue, and Full View. Each view must be at 300 percent magniﬁcation. Show Full View at start-up. Show the Pallet Queue when an empty pallet
arrives at the pallet queue location. Go back to showing the Full View when the
box is at the shipping dock. Here are the steps in deﬁning and naming views:
1. Select the View menu after the model layout is ﬁnished.
2. Select Views from the View menu.
The Views dialog box is shown in Figure L12.56. Figure L12.57 shows the Add
View dialog box. The Full View of the Shipping Boxes Inc. model is shown in
Figure L12.58.
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FIGURE L12.56

Views command in the View menu.

The Views dialog box.
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FIGURE L12.57
The Add View dialog
box.

Referencing a View in Model Logic

1. Select General Information (Figure L12.59) from the Build menu. Select
Initialization Logic and use the VIEW statement:
View "Full View"

2. Select Processing from the Build menu. Use the following statement in
the Operation ﬁeld when the Pallet Empty arrives at the Pallet Queue
location (Figure L12.60):
View "Pallet Queue"

Also, use the following statement in the Operation ﬁeld when the box
arrives at the shipping dock:
View "Full View"
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FIGURE L12.58
Full View of the Shipping Boxes Inc. model.

FIGURE L12.59
General Information
for the Shipping Boxes
Inc. model.
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FIGURE L12.60
Processes and routings at Shipping Boxes Inc. incorporating the change of views.

L12.13 Creating a Model Package
ProModel has an innovative feature of creating a package of all ﬁles associated
with the model ﬁle. This package ﬁle is titled <model name>.PKG—for example,
ATM.pkg. The package ﬁle can then be archived or distributed to others. This ﬁle
includes the model ﬁle (*.MOD), the graphic library (unless you check the Exclude Graphics Library option), and any external ﬁles you deﬁned (such as read
ﬁles, arrivals ﬁles, and shift ﬁles); the model package automatically includes
bitmaps imported into the background graphics. The package ﬁle can be subsequently unpackaged by the receiver to run.
Use the following steps to create a model package:
1. Select Create Model Package from the File menu.
2. Enter the name you wish to use for the model package. ProModel uses
the name of the model ﬁle as the default name of the package. So
ATM.mod will be packaged as ATM.pkg. You can also Browse . . . to
select the model name and directory path.
3. Check/uncheck the Exclude Graphics Library box, if you want to
include/exclude the graphics library.
4. Check the Protect Model Data box if you want to protect the data in your
model and prevent other users from changing and even viewing the
model data ﬁles.
5. Click OK.
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Example
For the Widgets-R-Us example in Section L12.6, make a model package that includes the model ﬁle and the shift ﬁle for operator Joe. Save the model package in
a ﬂoppy disk. Figure L12.61 shows the Create Model Package dialog.
Unpack
To unpack and install the model package, double-click on the package ﬁle. In the
Unpack Model Package dialog select the appropriate drive and directory path to
install the model ﬁle and its associated ﬁles (Figure L12.62). Then click Install.
After the package ﬁle has been installed, ProModel prompts you (Figure L12.63)
for loading the model. Click Yes.

FIGURE L12.61
Create Model Package
dialog.

FIGURE L12.62
Unpack Model
Package dialog.
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FIGURE L12.63
Load Model dialog.

L12.14 Exercises
1. Five different types of equipment are available for processing a special
type of part for one day (six hours) of each week. Equipment 1 is
available on Monday, equipment 2 on Tuesday, and so forth. The
processing time data follow:

Equipment

Time to Process One Part (minutes)

1
2
3
4
5

5±2
4±2
3 ± 1.5
6±1
5±1

Assume that parts arrive at a rate of one every 4 ± 1 hours, including
weekends. How many parts are produced each week? How large a
storage area is needed for parts waiting for a machine? Is there a
bottleneck at any particular time? Why?
2. Customers visit the neighborhood barbershop Fantastic Dan for a
haircut. Among the customers there are 30 percent children, 50 percent
women, and 20 percent men. The customer interarrival time is
triangularly distributed with a minimum, mode, and maximum of 8, 11,
and 14 minutes respectively. The haircut time (in minutes) depends on
the type of customer, as shown in this table:

Haircut Time (minutes)
Customers
Children
Women
Men

Mean

Half-Width

8
12
10

2
3
2
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The initial greetings and signing in take Normal (2, • 2) minutes, and the
transaction of money at the end of the haircut takes Normal (3, • 3) minutes.
Run the simulation model for 100 working days (480 minutes each).
a. About how many customers of each type does Dan process per day?
b. What is the average number of customers of each type waiting to get
a haircut? What is the maximum?
c. What is the average time spent by a customer of each type in the
salon? What is the maximum?
3. Poly Castings Inc. receives castings from its suppliers in batches of
one every eleven minutes exponentially distributed. All castings arrive
at the raw material store. Of these castings, 70 percent are used to make
widget A, and the rest are used to make widget B. Widget A goes from
the raw material store to the mill, and then on to the grinder. Widget B
goes directly to the grinder. After grinding, all widgets go to degrease
for cleaning. Finally, all widgets are sent to the ﬁnished parts store.
Simulate for 1000 hours.
Widget

Process 1

Process 2

Process 3

Widget A
Widget B

Mill [N(5,2) min.]
Grinder [U(9,1) min.]

Grinder [U(11,1) min.]
Degrease [7 min.]

Degrease [7 min.]

Track the work-in-process inventory of both types of widgets
separately. Also, track the production of ﬁnished widgets (both types).
4. The maintenance mechanic in the problem in Section L12.5.1 is an independent contractor and works four hours each day from 10 A.M. until 2 P.M.,
Monday through Friday, with no lunch break. The rest of the shop works
from 8 A.M. until 4 P.M. What will be the impact on the shop (average cycle
time and number of widgets made per day) if we hire him full-time and
have him work from 8 A.M. until 4 P.M. instead of working part-time?
5. Consider the United Electronics Exercise 7, in Section L7.12, with the
following enhancements. The soldering machine breaks down on
average after every 2000 ± 200 minutes of operation. The repair time
is normally distributed (100, 50) minutes. Create a simulation model,
with animation, of this system. Simulate this manufacturing system
for 100 days, eight hours each day. Collect and print statistics on the
utilization of each station, associated queues, and the total number of
jobs manufactured during each eight-hour shift (average).
6. Consider the Poly Casting Inc. example in Lab 7, Section L7.4, and
answer the following questions:
a. What is the average time a casting spends in the system?
b. What is the average time a casting waits before being loaded on a
mill? After a mill processes 25 castings, it is shut down for a
uniformly distributed time between 10 and 20 minutes for cleaning
and tool change.
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c. What percentage of the time does each mill spend in cleaning and
tool change operations?
d. What is the average time a casting spends in the system?
e. What is the average work-in-process of castings in the system?
7. Consider the NoWaitBurger stand in Exercise 13, in Section L7.12,
and answer the following questions.
a. What is the average amount of time spent by a customer at the
hamburger stand?
b. Run 10 replications and compute a 90 percent conﬁdence interval for
the average amount of time spent by a customer at the stand.
c. Develop a 90 percent conﬁdence interval for the average number of
customers waiting at the burger stand.
8. Sharukh, Amir, and Salman wash cars at the Bollywood Car Wash.
Cars arrive every 10 ± 6 minutes. They service customers at the rate of
one every 20 ± 10 minutes. However, the customers prefer Sharukh to
Amir, and Amir over Salman. If the attendant of choice is busy, the
customers choose the ﬁrst available attendant. Simulate the car wash
system for 1000 service completions (car washes). Answer the
following questions:
a. Estimate Sharukh’s, Amir’s, and Salman’s utilization.
b. On average, how long does a customer spend at the car wash?
c. What is the longest time any customer spent at the car wash?
d. What is the average number of customers at the car wash?
Embellishment: The customers are forced to choose the ﬁrst available
attendant; no individual preferences are allowed. Will this make a
signiﬁcant enough difference in the performance of the system to justify
this change? Answer questions a through d to support your argument.
9. Cindy is a pharmacist and works at the Save-Here Drugstore. Walkin customers arrive at a rate of one every 10 ± 3 minutes. Drive-in
customers arrive at a rate of one every 20 ± 10 minutes. Drive-in
customers are given higher priority than walk-in customers. The
number of items in a prescription varies from 1 to 5 (3 ± 2). Cindy can
ﬁll one item in 6 ± 1 minutes. She works from 8 A.M. until 5 P.M. Her
lunch break is from 12 noon until 1 P.M. She also takes two 15-minute
breaks: at 10 A.M. and at 3 P.M. Deﬁne a shift ﬁle for Cindy named
Cindy.sft. Model the pharmacy for a year (250 days) and answer the
following questions:
a. Estimate the average time a customer (of each type) spends at the
drugstore.
b. What is the average number of customers (of each type) waiting for
service at the drugstore?
c. What is the utilization of Cindy (percentage of time busy)?
d. Do you suggest that we add another pharmacist to assist Cindy? How
many pharmacists should we add?
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e. Is it better to have a dedicated pharmacist for drive-in customers and
another for walk-in customers?
f. Create a package ﬁle called SaveHere.pkg that includes the
simulation model ﬁle and the shift ﬁle Cindy.sft.
10. A production line with ﬁve workstations is used to assemble a product.
Parts arrive to the ﬁrst workstation at random exponentially distributed
intervals with a mean of seven minutes. Service times at individual
stations are exponentially distributed with a mean of three minutes.
a. Develop a simulation model that collects data for time in the system
for each part.
b. Additional analysis shows that products from three different priority
classes are assembled on the line. Products from different classes
appear in random order; products from classes 1, 2, and 3 have
highest, medium, and lowest priorities respectively. Modify the
simulation program to reﬂect this situation. Determine the mean time
in the system for the three different priority classes.
Class

1

2

3

Probability

0.3

0.5

0.2

c. The assembly process is modiﬁed so that each product to be
assembled is placed on a pallet. The production supervisor wants
to know how many pallets to place in operation at one time. It takes
Uniform(8 ± 2) minutes to move the pallet from station 5 to station 1.
Pallet loading and unloading times are Uniform(3 ± 1) minutes each.
Modify the simulation model to reﬂect this situation. Is it better to use
5 or 20 pallets?
11. Two types of parts arrive at a single machine where they are processed
one part at a time. The ﬁrst type of part has a higher priority and arrives
exponentially with a mean interarrival time of 30 minutes. The second
lower-priority type also arrives exponentially with a mean interarrival
time of 30 minutes. Within priority classes, the parts are serviced in
FIFO order, but between priority classes the higher-priority type will
always be processed ﬁrst. However, a lower-priority part cannot be
interrupted once it has begun processing. The machine processing times
for higher- and lower-priority types of parts are uniformly distributed
(20 ± 5) and (8 ± 2) minutes, respectively. Simulate the system for
1000 hours.
a. What are the average time in queue and average time in system for
each type of part?
b. What are the average production rates of each type of part per hour?
12. The manufacture of a certain line of composite aerospace subassembly
involves a relatively lengthy assembly process, followed by a short
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ﬁring time on an oven, which holds only one sub-assembly at a time.
An assembler cannot begin assembling a new sub-assembly until he or
she has removed the old one from the oven. The following is the pattern
of processes followed by each assembler:
a. Assemble next subassembly.
b. Wait, ﬁrst-come, ﬁrst-served, to use the oven.
c. Use the oven.
d. Return to step a.
Here are the operating times and relevant ﬁnancial data:

Operation

Time Required
(minutes)

Assemble
Fire

30 ± 5
8±2

Cost Information
($)

Item
Assembler’s salary
Oven cost
Raw material
Sale price of ﬁnished sub-assembly

$35/hour
$180 per 8-hour workday
(independent of utilization)
$8 per sub-assembly
$40 per sub-assembly

Build a simulation model of this manufacturing process. Use the model
to determine the optimal number of assemblers to be assigned to an
oven. The optimal number is understood in this context to be the one
maximizing proﬁt. Base the determination on simulations equivalent
to 2000 hours of simulated time. Assume there are no discontinuities
within a working day, or in moving between consecutive eight-hour
working days. (Adapted from T. Schriber, Simulation using GPSS, John
Wiley, 1974.)
13. For the following ofﬁce work, the likelihood of needing rework after
audit is 15 percent. Interarrival times are exponentially distributed
with a mean of 5 minutes, rework times are exponentially distributed

Office work

Audit

15%

Rework
85%
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with a mean of 4 minutes, audit time is uniformly distributed between
2 ± 1 minutes, and work times are normally distributed with an average
time of 4.5 minutes and standard deviation of 1.0 minute.
a. What is the mean time in the system for the ﬁrst 200 reworked ofﬁce
ﬁles?
b. Develop a histogram of the mean time in the system for the ﬁrst
1000 departures.
c. Modify the simulation program so that ofﬁce work is rejected if it
fails a second audit. How many ofﬁce ﬁles are inspected twice? How
many of these fail the audit a second time?
d. Modify the program to count the number of ofﬁce ﬁles staying in the
system longer than a speciﬁed length of time. What percentage of the
ofﬁce work stays in the system for more than 12 minutes?
e. Modify the part a simulation program so that it takes uniform
(3 ± 1) minutes to move the ofﬁce ﬁle from one station to another.
f. Modify the part a simulation program so that ﬁles to be reworked for
second or more times have a lower priority than ﬁles needing rework
for the ﬁrst time. Does it seem to make a difference in the overall
mean time in the system?

